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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG (“Siemens”). They are non-
binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 
By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  
The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with industrial security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 
Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  
For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity.

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Introduction and task description 
 

This application example offers you a finished circuit for LOGO! 8 for controlling 
four conveyor belts via digital inputs and outputs. 

 

 

WARNING 

This example demonstrates the functional implementation with LOGO! 

Possible requirements regarding functional safety (e.g. EMERGENCY stop) 
are not part of this example. 

The user is responsible for compliance with the relevant guidelines! 

 

The integrated functions of a LOGO! 8 offer many additional possibilities to solve 
applications in various areas quickly and easily. 

 

With LOGO!, prefabricated function blocks support project creation, e.g. weekly 
time switch, pulse generator, astro timer, seasonal time switch, stopwatch and 
simple logic gates. 

 

The LOGO! text display (TDE) and the integrated web server of the LOGO! 8 offer 
additional options for operation and monitoring using function keys and message 
texts. 

 

Advantages of LOGO! versus a conventional electrical installation 

Using LOGO! 8 offers you the following advantages: 

• Extendibility of the software program to include further tasks.  
In addition to the conveyor belts, other conveyor systems can be planned 
depending on the situation, e.g. a lifting platform or an unloading aid for 
vehicles. 

• Simple, star-shaped wiring of the components 

• Use of simple switches (circuit breakers) or buttons 

• Fewer components are required compared to a conventional solution. 

Target group 

This application example is aimed at specialist electrical installation staff. 
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Task description 

In a conveyor belt system, transported goods are to be moved over four conveyor 
belts set up one behind the other, as shown in Figure 1-1. 

 

The conveyor belts should start running one after the other by pressing one button 
and stop one after the other by pressing another button. 

During startup, the conveyor belt (4) starts first, followed by (3), (2) and (1) after a 
time delay. 

When the system is stopped, conveyor belt (1) should stop first so that no 
transported goods will continue to be moved.  

When conveyor belt 2 is idling, it stops after a defined period of time has elapsed. 

Conveyor belts 3 and 4 then stop after a corresponding delay. 

This guarantees that the system will not start under full load the next time it is 
started. 

If a fault occurs in a conveyor belt, the preceding conveyor belts are switched off.  

Select a LOGO! variant for 24V or 230V according to the drive control for the 
conveyor belts. 

The integrated LOGO! web server function can also be used to remotely control the 
system via smartphone or tablet. 

 

Figure 1-1: Controlling a conveyor belt system with LOGO! and LOGO! TDE 

1 2 3 4

LOGO! 8 LOGO! TDE

1 2 3 4

4 3 2 1

Startup

Stop
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2 Components used 
The application example uses the LOGO! base unit and a digital expansion module 
as shown in Table 2-1. 

 

Table 2-1: Hardware and software components for the application example 

Component Quantity Article number Note 

LOGO! Soft 
Comfort V8.2 DVD 

1 6ED1058-0BA08-0YA1 You can find an upgrade 

to V8.2 at: 
http://www.siemens.de/logo 

LOGO! POWER  
24 V / 1.3 A 

1 6EP3331-6SB00-0AY0 - 

LOGO! 12/24 RCE 1 6ED1052-1MD08-0BA0 4 relay outputs 

LOGO DM16 24R 1(1) 6ED1055-1NB10-0BA2 8 relay outputs 

LOGO! TDE 1 6ED1055-4MH08-0BA0 Optional components 

Alternatively Quantity Article number Note 

LOGO! 230RCE 1 6ED1052-1FB08-0BA0 230V version with 4 relay 
outputs 

LOGO DM16 230R 1(1) 6ED1055-1FB10-0BA2  

(1) You can replace two identical DM8 expansion modules with one DM16 expansion module of the 

same type (and vice versa) without changing the switching program. 

 

Note If you want to use the application example with a LOGO! 230RCE (for 230V), 
you will find additional information in the following article: 

TDE central control for general users: 

- https://support.industry.siemens.com/cs/ww/en/view/109755864 

 

This application example consists of these instructions and the LOGO! switching 
program. 

 

Table 2-2: Connectors for our application example 

Component File name Note 

Documentation 109766186_LOGO!_ConveyorControlSystem_de.pdf - 

LOGO! Program 109766186_LOGO!_ConveyorControlSystem_de.zip Requirements: 

LOGO! Soft 

Comfort V8.2 

LOGO! TDE 

The LOGO! TDE external text display for LOGO! 8 provides you with an 
inexpensive and central user interface for your applications. You can adjust 
parameters and use the LOGO! TDE for troubleshooting. The configuration of 
LOGO! TDE and the internal LOGO! display is done using the same function block. 

The use of the TDE allows the display of all messages via the integrated web 
server and thus also the control of applications via a smartphone. 

  

http://www.siemens.de/logo
https://support.industry.siemens.com/cs/ww/en/view/109755864


3 Commissioning 

 

LOGO! - Conveyor Control System 
Article ID: 109766186,    V1.0,    05/2019   7 
 

©
 S

ie
m

e
n
s
 A

G
 2

0
1
9
 A

ll 
ri

g
h
ts

 r
e
s
e
rv

e
d
 

3 Commissioning 
This Chapter includes basic information on the commissioning of the LOGO! 8 
applied here. 

 

Note For further information on mounting and wiring, please refer to the manual (\3\), 
Chapter: (LOGO! mounting and wiring). 

Follow the connection instructions in the product information supplied with your 
device. 

Connecting LOGO! TDE 

The LOGO! TDE must be operated with a voltage of 12V DC or 24V AC/V DC and 
is installed separately. Siemens recommends protecting the LOGO! TDE by means 
of an 0.5 A fuse at the power supply. 

The voltage connection is not polar. If you connect a DC power supply to the 
LOGO! TDE, you can connect the positive supply line or the negative supply line 
according to Figure 3-1 (2) either to pin 1 or to pin 2. Pin 3 must be connected to 
the ground. 

Communication to LOGO! takes place via the Ethernet interface (1). 

 

Figure 3-1: Connection of LOGO! TDE 

1 2

 

Note The connection settings between LOGO! and LOGO! TDE can be found in the 
manual (\3\), Chapter: (LOGO! TDE settings menu). 

You can find information on the LOGO! web server settings here: 

• Activating the web server 

• Operating the virtual base module on the web server 

 

Commissioning the application example 

Proceed as follows: 

1. Start the LOGO! Soft Comfort V8.2 

2. Open the supplied LOGO! example program *.lsc 

3. Transfer the program to LOGO! 

 

Note In the application example, the IP address 192.168.0.3 has been preset for 
LOGO! You will find a description of the general procedure for assigning the IP 
address of a LOGO! 8 in the manual (\3\), Chapter: (Configuring network 
settings). 

https://support.industry.siemens.com/cs/ww/de/view/109741041/65414900619
https://support.industry.siemens.com/cs/ww/de/view/109741041/65414900619
https://support.industry.siemens.com/cs/ww/de/view/109741041/85143681803
https://support.industry.siemens.com/cs/ww/de/view/109741041/65414900619
https://support.industry.siemens.com/cs/ww/de/view/109741041/98458459403
https://support.industry.siemens.com/cs/ww/de/view/109741041/98458459403
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4 Principle of operation of the switching 
program 
This application example shows the LOGO! switching program and the functions it 
contains for the LOGO! Soft Comfort software. 

For the purposes of illustrating the LOGO! switching program, the simulation 
function is available in LOGO! Soft Comfort, allowing you to test individual 
adaptations directly. Follow the course of the red active switching signals in the 
LOGO! switching program. 

In Table 4-1 shown below, all input and output signals of the application example 
are listed. 

Please note that the inputs [I7] and [I8] of the LOGO! base unit are used as digital 
inputs. In LOGO! Soft Comfort, [I7] and [I8] are used at the factory as analog inputs 
[AI1] and [AI2]. 

Note Change these settings as follows: 
> “File” > “Properties” > “I/O Settings” > “Activate 0 AI”. 

 

Table 4-1: Input and output signals in LOGO! 

Signals Keys/switches Description 

Input [I1] (Close) button  Conveyor belt 1 (ON) 

Input [I2] (Open) button  Conveyor belt 1 (OFF) 

Input [I3] (Close) button  Conveyor belt 2 (ON) 

Input [I4] (Open) button  Conveyor belt 2 (OFF) 

Input [I5] (Close) button  Conveyor belt 3 (ON) 

Input [I6] (Open) button  Conveyor belt 3 (OFF) 

Input [I7] (Close) button  Conveyor belt 4 (ON) 

Input [I8] (Open) button  Conveyor belt 4 (OFF) 

Input [I9] (Open) button  Conveyor belt 1 (fault) 

Input [I10] (Open) button  Conveyor belt 2 (fault) 

Input [I11] (Open) button  Conveyor belt 3 (fault) 

Input [I12] (Open) button  Conveyor belt 4 (fault) 

Input [I13] (Close) button  Operation (time delay ON) 

Input [I14] (Open) button Operation (time delay OFF) 

Input [I15] Switches Operation (ON / OFF) 

Outputs [Q1] to [Q4] Conveyor belt drives [1] to [4] 

 

Note You will find a functional description of the LOGO! switching program as a 
comment on the switching program under LOGO! Soft Comfort: 
  > “File” > “Properties” > “Comment” 
Alternatively:  > “Extras” > “Device selection” > “Comment” 

Hint: Select “Extras” > “Options” > “Print” and check the “Comment” box to print 
the function description together with the program. 
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Basic switching functions 

Figure 4-1 shows the LOGO! switching program for the conveyor belt system. 
The system contains a part for automatic operation (position 1) and the individual 
operating devices for the conveyor belts (2). 

In the switching program, the incompatible operating states of the system are 
locked against each other by simple logic blocks.  

The individual switching functions are described specifically in the following pages 
of this documentation. 

 

Figure 4-1: LOGO! switching program – Overview 

1

2

 



4 Principle of operation of the switching program 

 

LOGO! - Conveyor Control System 
Article ID: 109766186,    V1.0,    05/2019   10 
 

©
 S

ie
m

e
n
s
 A

G
 2

0
1
9
 A

ll 
ri

g
h
ts

 r
e
s
e
rv

e
d
 

Basic switching functions and display of the message texts 

For the purpose of illustrating the system states, various message texts have been 
planned which are displayed in Figure 4-2. The red positions (1-4) represent the 
active operation, the white positions represent the result. 

The system is switched to the “ON” or “OFF” operating state (position 1) via the 
[I15] button. 

The “OFF” operating state is signified by a passive “green” in the LOGO! display 
and the LOGO! TDE, the “ON” operating state is signified by an active white 
backlight on both displays. 

For “ON”, message text [B010] is activated where the message text priority is set to 
“OFF” via the priority of message text [B045]. 

If the system is switched on, you have the option of controlling the conveyor belts 
individually using the respective buttons, or of having the conveyor belts switched 
on automatically using button [I14] (2) with a time delay. The startup of each 
conveyor belt is symbolized by a bar diagram in the message text. 

If you wish to specifically switch off the system, press the button on [I13] (3). 

Depending on the task description, the conveyor belts switch off one after the 
other. The message text display changes to “Orange” and the LOGO! TDE displays 
the remaining time until the respective conveyor belt is switched off. 

If a fault is detected on a conveyor belt, it switches to the “OFF” operating state 
along with the preceding conveyor belts and the message text is set to “Red”.  

After the fault has been rectified, you can switch the affected conveyor belts on 
again manually or start them automatically using [I14]. 

 

Figure 4-2: Basic switching functions and display of the message texts 

3

4

2

11

2

3

4

 

Note For better understanding, use the simulation function of LOGO! Soft Comfort 
([F3] button). The blue strings represent the LOW signal, the red strings the High 
signal. 
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Figure 4-3 on the following page shows essential individual functions at the 
respective positions in the context of the LOGO! circuit program. 

 

• Position (1) – Reset trigger during operation (ON/OFF) 

When switching [I15] from “ON” to “OFF”, a trigger is generated via the negative 
edge evaluation [B058] (1). When switching from “ON” to “OFF”, the evaluation 
takes place via a positive edge [B059]. 

Using the OR operation [B060], the system is always reset to the initial state in this 
way when the operating states are changed. 

 

• Position (2) – Signal origin as help text on blocks 

In the circuit, you will find text fields at the inputs and outputs of each block, 
indicating the function and origin of a signal (2). 

Specifically, the trigger resets the delayed switching on of “Belt_1” at block [B044]. 

 

• Position (3) – Block for switching off with time delay 

Switching off the conveyor belts with a time delay is carried out by opening [I14]. In 
this way, the trigger input at the “Storing switching on delay" [B016] block is 
negated to stop “Belt_2” (3) with a delay. 

After the set time has elapsed, within the block parameters, the belt is switched off 
via the reset trigger on the latching relay block [B003]. 

 

• Position (4) – Alternating fault message in message text 

If a fault (4) is detected on a conveyor belt, it is output on the LOGO! display and 
the TDE.  

The trigger generator [B049] alternately displays the text “Belt_3” and “Fault” in the 
message text. 

 

• Position (5) – Display of the conveyor belt startup in the message text 

When a conveyor belt is switched on, startup bar diagrams signal the startup of 
respective conveyor belt. 

Block [B028] “Analog ramp” for Belt_4 is used for this purpose. 
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Figure 4-3: Individual functions in the LOGO! circuit program 

 

1

2

3

4

5
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Configuration of a message text 

As shown above, message texts are used for the respective operating status of the 
system and the conveyor belts. 

Figure 4-4 an example of the structure of a message text based on switch off with 
time delay. Here, the respective parameters of the circuit blocks are integrated in 
the message text. 

 

Figure 4-4: Configuration of a message text 
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5 Appendix 

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services. Product information, manuals, downloads, FAQs, 
application examples and videos – all information is accessible with just a few 
mouse clicks: support.industry.siemens.com 

SITRAIN – Training for Industry 

We support you with our globally available training courses for industry with 
practical experience, innovative learning methods and a concept that’s tailored to 
the customer’s specific needs. 

For more information on our offered trainings and courses, as well as their 
locations and dates, refer to our web page: www.siemens.com/sitrain 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for Apple iOS, Android and Windows 
Phone: https://support.industry.siemens.com/cs/ww/en/sc/2067  
 

5.1 Links and Literature  

Table 5-1: Links and Literature 

Nr. Thema 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ This entry 

https://support.industry.siemens.com/cs/ww/en/view/109766186 

\3\ LOGO! 8 user manual 

https://support.industry.siemens.com/cs/ww/en/view/109741041 

\4\ LOGO! logic module (application examples, expansion modules) 

https://www.siemens.com/global/en/home/products/automation/systems/industrial/pl
c/logo.html 

5.2 Change documentation 

Table 5-2: Change documentation 

Version Date Change 

V1.0 05/2019 First edition 

   

 

https://support.industry.siemens.com/
https://www.siemens.com/sitrain
https://support.industry.siemens.com/cs/ww/en/sc/2067
https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/109766186
https://support.industry.siemens.com/cs/ww/en/view/109741041
https://www.siemens.com/global/en/home/products/automation/systems/industrial/plc/logo.html
https://www.siemens.com/global/en/home/products/automation/systems/industrial/plc/logo.html
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